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Good Morning & Welcome Back! 
Day 4 

 
. 
 
 
 “Help another to climb the hill, and you will find yourself 

nearer the top." 
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Multimedia Technology 
 
What is multimedia? 
Multimedia simply means being able to communicate in more than one way. Actually, working 
with multimedia is nothing new. Any time you use more than one method of communicating 
information, you are using multimedia. Computers are very good at mixing media. A typical 
multimedia presentation is one that includes several of the following elements: 
 

Text 
Graphics 
Sound 

Video (Animation) 
 
Multimedia Hardware: 
To create multimedia presentations, you will need a multimedia computer.  A typical 
multimedia computer includes the following components: 
 

Speakers 
Sound Card  

CD-ROM Drive 
Microphone 

 
If your budget permits, it is nice to have the following hardware accessories: 
 

Scanner  
Digital Camera 

 
A scanner allows you to scan pictures from a hard copy, and a camera allows you to take 
digital pictures that can be accessed directly by your computer. 
 
Multimedia Authoring Software: 

KidPix4  
HyperStudio 
PowerPoint 
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Planning, Producing and Assessing a 
Multimedia Project 

 
Planning 
Multimedia projects usually take longer to complete than traditional projects; therefore, 
proper planning is a must. Consider the following: 

 
• What type of multimedia slide show will your students complete? (Alphabet, Animals, 

My favorite..., All about me, 100 slide show, Research Report, Science Concepts, Class 
slide show for Open House) 

 
• How will you group your students?  You may want to start small.  A whole group class 

slide show in which each student contributes one slide is a manageable beginning for 
first time student and (and teacher) users. As you and your students become more 
comfortable with the program, you will want to explore small group projects. Each 
group will produce a slide show about a chosen topic, which supports the current unit of 
study (such as plants and animals native to a habitat). Showcase the talents of your 
students by allowing them to present their multimedia slide shows to the entire class! 
Individual projects may include book reports, book reviews, science or social studies 
projects, and demonstration of math concepts. The possibilities are endless. 

 
• How much time will you allow for this activity? Will the students rotate through the 

classroom computer? Will the lab be available for use? 
 

• How will your students plan? What storyboards, or planning and organizing tools will 
they need? 
 

Producing 
Discuss the following production tips with your students: 

• Illustrations should be large and colorful! 
• Text should be large and easy to read. 
• Be creative! Use only a few stamps! Original artwork is very COOL! 
• Speak slowly and clearly when recording sound. Play an audio CD softly in the 

background during the slide show.  
 

Assessing 
It is important to consider your standards and learning objectives carefully when planning 
a multimedia project. When you consider your content area standards (science, for 
example) along with language arts/writing, you will be surprised at how many lesson 
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objectives your students will meet during the project. When planning for assessment, 
consider the following ideas:  

 
Planning: 

• Did the student complete a storyboard? 
• Did a peer editor or teacher approve the draft before the student went to 

the computer? 
 

Content: 
• Were the QCC standards met? Was there sufficient content in the project? 

Was it accurate?  Was it organized? 
 

Mechanics: 
• Was the slide show edited for correct grammar, spelling, capitalization, and 

punctuation? 
 

Creativity: 
• Did the slide show include a beginning and ending slide? 
• Did the artwork and stamps support the topic of the slide? 
• Did the slide show demonstrate creativity and originality? 
• Did the sound in the slide show appropriately enhance the presentation? 
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Whale-Animalia Lesson Plan 
Teaching 
Strategies 
Modeled 

Technology 
Strategies 
Modeled 

Instruction 
Essential Questions for Teachers: How do I gather information from the 
Internet?  How do I create a KidPix slideshow? 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Essential Question: What are some of the various types of 
whales and what do they have in common?   
 
Learning Standards (State of Michigan): 
Assessed:  
English Language Arts Standard 3: Later Elementary  
Integrate listening, speaking, viewing, reading, and writing skills 
for multiple purposes and in varied contexts.  
 
English Language Arts Standard 3: Early Elementary  
Integrate listening, speaking, viewing, reading, and writing skills 
for multiple purposes and in varied contexts. Examples include 
using more than one of the language arts to create a story, write 
a poem or letter, or to prepare and present a unit project on 
their community. 
 
Science Standard I.1:Elementary 
Develop strategies and skills for information gathering and 
problem solving. ( Tools: Sources of information, such as 
reference books, trade books, periodicals. Real-world contexts: 
Seeking help from peers, adults, libraries, other resources.) 
 
Science Standard I.1: Elementary 
Develop strategies and skills for information gathering and 
problem solving.  
(Tools: Sources of information, such as reference books, trade 
books, periodicals. Real-world contexts: Seeking help from peers, 
adults, libraries, other resources.) 
 
Materials: Student reproducibles, Whale CD’s, Internet 
connection, word processing software, Animalia by Graeme Base, 
Kid Pix Studio Storyboards 
 
Technology Connections: Students will gather information from 
the Internet and CD roms on an assigned whale. They will create 
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Teaching 
Strategies 
Modeled 
 
 
 
Whole 
Group 
Instruction 
 
 
Individual 
Work 
 
 
 
 
 
 
 
Peer Editing 
 
 
Individual 
Work 
 
 
 
 
 
 
Whole 
Group 
 
 
 
Whole 
Group 
 
 
 
Small 
Groups- 
Learning 
Stations 
 
 
 
 
 
 
 

Technology 
Strategies 
Modeled 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
KidPix Studio 
 
Ideas for 
using KidPix 
Slide Show in 
the 
classroom- 
http://course
web.tac.unt.e
du/rhondac/K
idPix.htm 
 
 
 
 
 
Internet 
Whales CD 
Encarta CD 
Whales Video 
Imagination 
Express: 
Oceans 
 
 
 
 
 
 
 

an alliteration with their group and publish a multimedia show 
using KidPix. 
 
Procedures: 
  Individual Activity: 

• Read Animalia by Graeme Base to the whole group.   
• Discuss parts of speech and alliteration found in 

Animalia. 
• Each student will write and illustrate a sentence which 

includes age-appropriate parts of speech - adjectives, 
nouns, verbs, and adverbs, as well as alliteration.  The 
sentence should be about the whale they have been 
assigned.    

• Students will use a storyboard to plan a slide for their 
whale. 

• Students will use peer editors to check for grammar, 
parts of speech, alliteration and mechanics. 

• Students will use Kid Pix Studio and their storyboards 
to create a slide.  This may be done during learning 
centers, in the computer lab, or individually during class 
time. 

• The teacher will compile all slides into a class slide 
show. 

• The whole class will view the completed slide show. 
 

  Small Group Activity: 
• Read Animalia by Graeme Base to the whole group.   
• Discuss parts of speech and alliteration found in 

Animalia. 
• Divide class into five collaborative learning groups. 

Have the groups rotate to the following five stations: 
Station 1: Internet Hotlist 
Station 2:  Whales CD 
Station 3:  Encarta 
Station 4:  Whales Video 
Station 5:  Imagination Express: Oceans 

 
• The groups will rotate to each station. They should 

locate one of the team member’s whale at each station. 
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Teaching 
Strategies 
Modeled 
 
How to use 
Learning 
Stations in 
your 
classroom- 
http://www.
essdack.org/
stations/  
Small Group 
 
 
 

Technology 
Strategies 
Modeled 
 
 
KidPix Studio 

Observe a picture of the animal, describe the picture, 
and categorize the words as nouns, verbs, adjectives, 
and adverbs. As a group, write an alliteration sentence 
for each whale.  

• As a whole group, teach students how to use the basic 
Kid Pix Studio tools. 

• Each student will create and save their own alliteration 
slide to a disk. 

• Each collaborative learning group will create a slide 
show with includes the team members’ individual slides 
along with a title slide and an ending slide. 

Assessment:  
Grades 3-5: Students will be assessed using the 
multimedia rubric. 
Grades K-2: Students will be assessed using the 
multimedia rubric. 
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Animalia Slide Show Student Self-Assessment 
 

Name Date  
 

 
Use the following scale to see how well you did on your slide: 

 
Empty Bag - I did not complete the slide. 
Cookie Crumbs - I did not give this slide very much attention. There is a lot of room for 
improvement. 
Broken Oreo - This slide is not quite an Oreo. I tried to follow the directions and work 
neatly, but I know this is not my best effort. This slide could have been better. 
Oreo - I followed all of the directions. It is done neatly. It is my best effort, and I am 
proud of my work. 
Frosted Oreo - Everything is an Oreo AND I added something extra special. 
 
 
My slide was about a whale. 
Empty Bag    Cookie Crumbs     Broken Oreo     Oreo  Frosted Oreo 
 
My slide demonstrated alliteration. 
Empty Bag    Cookie Crumbs     Broken Oreo     Oreo  Frosted Oreo 
 
My slide included adjectives, nouns, and verbs. 
Empty Bag    Cookie Crumbs     Broken Oreo     Oreo  Frosted Oreo 
 
My slide was edited for correct use of capitalization, punctuation, and spelling. 
Empty Bag    Cookie Crumbs     Broken Oreo     Oreo  Frosted Oreo 
 
My slide show illustrations showed detail and creativity. 
Empty Bag    Cookie Crumbs     Broken Oreo     Oreo  Frosted Oreo 
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Animalia Slide Show Teacher Assessment 
 

Name Date  
 

Use the following scale to see how well you did on your slide: 
 

Empty Bag - I did not complete the slide. 
Cookie Crumbs - I did not give this slide very much attention. There is a lot of room for 
improvement. 
Broken Oreo - This slide is not quite an Oreo. I tried to follow the directions and work 
neatly, but I know this is not my best effort. This slide could have been better. 
Oreo - I followed all of the directions. It is done neatly. It is my best effort, and I am 
proud of my work. 
Frosted Oreo - Everything is an Oreo AND I added something extra special. 
 
 
The slide was about a whale. 
Empty Bag    Cookie Crumbs     Broken Oreo     Oreo  Frosted Oreo 
 
The slide demonstrated alliteration. 
Empty Bag    Cookie Crumbs     Broken Oreo     Oreo  Frosted Oreo 
 
The slide included adjectives, nouns, and verbs. 
Empty Bag    Cookie Crumbs     Broken Oreo     Oreo  Frosted Oreo 
 
The slide was edited for correct use of capitalization, punctuation, and spelling. 
Empty Bag    Cookie Crumbs     Broken Oreo     Oreo  Frosted Oreo 
 
The slide show illustrations showed detail and creativity. 
Empty Bag    Cookie Crumbs     Broken Oreo     Oreo  Frosted Oreo 
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Alliteration Words 

 
Type of Whale___________________________ My Letter___________ 
 
Nouns Verbs Adjectives Adverbs 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

   

 
My whale alliteration ___________________________________________________ 

 
___________________________________________________________________ 
 
___________________________________________________________________
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Team Member Alliterations 
 

Whale Type ____________________________ 
 
Alliteration __________________________________________________________ 
 
___________________________________________________________________ 
 
___________________________________________________________________ 
 

 
Whale Type ____________________________ 
 
Alliteration __________________________________________________________ 
 
___________________________________________________________________ 
 
___________________________________________________________________ 
 

 
Whale Type ____________________________ 
 
Alliteration __________________________________________________________ 
 
___________________________________________________________________ 
 
___________________________________________________________________ 
 

 
Whale Type ____________________________ 
 
Alliteration __________________________________________________________ 
 
___________________________________________________________________ 
 
___________________________________________________________________ 
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Whale Alliteration Slide Show 
Kid Pix Studio Deluxe Steps 

 
Getting Started: 
1.  Have a blank floppy disk prepared on which to save slides. 
 
2.  Open Kid Pix Studio Deluxe.  From the Picker menu, choose Kid Pix. 
  
Slide 1 - Title Slide: 
 
1.  Add a background: 

• Click the Paint Bucket Tool.  Select a color from the Color Palette.  Select a 
pattern from the Options Tray.   Move the Paint Bucket onto the page and click. 

 
2. Add a title: “A Whale of a Time” 
• Click the Typewriter Tool.  Select a font, size, and style from the Options Tray.  Scroll 

to choose a font, or double-click the font window to choose a font from a list.  Select a 
color from the Color Palette.  Click to plant the cursor on the screen.  Begin typing.   

 
3.   Editable text is a new feature available in Kid Pix Studio Deluxe.  Text boxes float 

above the background, making them easy to edit and move.  Simply click the Typewriter 
Tool, then click to select a text box.  You may now change the font, size, color, etc. or 
move the text box by clicking and dragging.  To edit text, click to plant the cursor.  
Then backspace over text to remove letters or words.  Type to add text.  It’s that 
easy!   

 
4. If you are NOT using the Deluxe version of Kid Pix Studio, you do NOT have editable 

text boxes.  Follow the steps below to center the title. 
 

5.  Center the title: 
• Click the Moving Van Tool.  Click the Magnet in the Options Tray.  Your cursor 

will become a +.  Move the + to the upper left portion of the title.  Click, hold and 
drag to select the title.  You will see marching ants around the title.  Click in the 
middle of the title (you will see the magnet), hold and drag the title until it 
appears centered.  Follow the same procedure to center any other text.   

 
6.  Fill in white spaces: 
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• Click the Eyedropper Tool.  Move the Eyedropper onto the background and click.  
This tool picks up the exact color of the background.  Now click the Paint Bucket.  
Move the Paint Bucket to white areas and click to fill with background color. 

 
7.  Add a second row of text:  By _________ 

• Click to plant the cursor in the desired location on the screen.  Choose a font, 
size, color and style.  Begin typing. 

 
8.  Resize text boxes: 

• Click one of the red handlebars on the text box.  Click, hold, and drag to resize. 
 

9. Hear text read aloud: 
• Under the Speech Menu, choose Read Text Aloud.  (This feature will not work if 

text is painted to the background.) 
 
• If a word is mispronounced, you may edit the speech by choosing How to 

Pronounce from the Speech Menu. 
 
10.  Paint text to background: 

• Text boxes float above the background.  You may choose to affix the text boxes 
to the background .  Click the Typewriter Tool.  Under the Toolbox Menu, choose 
Paint Text to Background.  You may paint only the active text box, or all text 
boxes to the background.  When you paint the text to the background, it may no 
longer be edited!!  In addition, if text is painted onto the background, it may not 
be read aloud! 

 
11.  Record a sound: 

• Under the Goodies Menu, choose Record a Sound.  Click the Record Button.  
Record your text for the title slide.  Click the Stop Button.  Click the Play Button 
to preview the recording.  Click Save. 

 
 

12.  Decorate the title page: 
• Click the Rubber Stamp Tool.  Under the Goodies menu, pull down to Pick a Stamp 

Set.  Scroll down until you see the Nature stamp set.  Click to choose the Nature 
stamp set.  Click OK. 
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• Scroll through the Options Tray to find stamps of ocean animals.  Click to select 
the stamp you wish to use.  Your cursor will become the stamp.  Move the stamp 
onto the page in the desired location.  Click to place stamp.   

 
13.  Enlarge stamps: 

• Press the Control key to make the stamp one size larger.  While the Control key 
is pressed down, click to stamp. 

• Press Control and Shift to make the stamp even larger.  Click to stamp while 
holding down Control and Shift. 

 
14.  Edit a stamp: 

• Click to select the stamp you wish to edit.  Under the Toolbox menu, click Edit A 
Stamp.  You may flip the stamp, draw on it, paint it a different color, etc.  When 
you are finished editing, click OK.  Click to stamp.  When you are finished with 
that stamp, go back to Edit A Stamp under the Toolbox menu.  Click Restore 
Original to restore the stamp to its original position and color.  Click OK.  You 
may also double-click the stamp in the Options Tray to access the stamp editor. 

 
15.  Save slide 1: 

• Select Save a Picture under the File menu.  Choose a location in which to save.  
(floppy disk - A drive)  Name your picture (slide1).  Select Save Sound.  Click OK. 

 
Slide 2: 
 
1.  Add a new page: 

• Choose New from the File menu. 
 

2.  Add a background:   
• Click the Paint Bucket Tool.  Select a color from the Color Palette.  Select a 

pattern from the Options Tray.   Move the Paint Bucket onto the page and click. 
 
3.  Draw a picture: 

• Use the Pencil Tool to draw a picture on the page.  Notice you have two Option 
Trays - one has a blunt pencil point, one has a rounded pencil point. Make sure all 
lines are connected.  Fill your picture using the Paint Bucket. 

 
4.  Erase: 

• Use the Eraser Tool’s first four options to erase small mistakes.   
• The remaining options in the Options Tray will erase the entire page.   
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5.  Undo: 
• Click the Undo Man to undo your last operation if you make a big mistake.   
 

6.  Add text:   
• Click the Typewriter Tool.  Select a font, size, and style from the Options Tray.  

Scroll to choose a font, or double-click the font window to choose a font from a 
list.  Select a color from the Color Palette.  Click to plant the cursor on the 
screen.  Begin typing.   

 
7.  Record a sound: 

• Under the Goodies Menu, choose Record Sound.  Click the Record Button.  Record 
your text for the title slide.  Click the Stop Button.  Click the Play Button to 
preview the recording.  Click Save. 

 
8.  Save slide 2: 

• Select Save a Picture under the File menu.  Choose a location in which to save.  
(floppy disk - A drive)  Name your picture (slide2).  Select Save Sound.  Click OK. 

 
Slide 3: 
 
1.  Add a new page: 

• Choose New from the File menu. 
 
2.  Insert a graphic from an outside source: 

• From the File Menu, choose Import a Graphic. 
• Find a graphic that you wish to use.   
• You will see a preview of the graphic on the left side of the Import a Graphic 

window.  You may rotate the graphic by clicking the rotate arrows below the 
graphic preview. 

• Choose to position the graphic on the drawing area by selecting one of the 
following options: 
 Fill Screen will make the graphic fill the entire drawing area   
 (picture may get distorted). 
 Scale to Fit will make the graphic fit the drawing area    
 proportionally. 
 Center will place the graphic in the middle of the drawing area.  It  
 will appear in its original size. 
 Upper Left will place the graphic in the upper left corner of the  
 drawing area.  The graphic will appear in its original size. 
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 Scale Manually will enable you to move and resize the graphic by  
 hand. 
 
* Scale manually is an option available only in Kid Pix Studio Deluxe. 

 
• Choose Scale Manually.  Click OK. 
• Move the graphic by clicking, holding, and dragging from the center of the 

graphic.   
• Resize the graphic by clicking, holding, and dragging from one of the blue 

handlebars.  Drag inward to reduce the size of the graphic.  Drag outward to 
increase the size of the graphic. 

• Position the graphic.  Click outside the graphic area to place graphic on page. 
 
3.  Select a background color: 

• Choose the Eyedropper Tool.   Click a desired color on the graphic to choose a 
background color.  This places the desired color on the Color Palette. 

 
4.  Add a background: 

• Choose the Paint Bucket Tool.  Your selected color should be on the Color Palette.  
Click to paint the background. 

• Some graphics may have a white border around them.  If this is the case, you 
may use the Paint Bucket Tool to fill in the white border.  Occasionally, paint will 
bleed into your graphic.   You may choose to frame the graphic.  Choose the 
Rectangle Tool, and the Transparent Option in the Options Tray.  (Transparent 
Option is the third one from the left.)  Click, hold, and drag to draw a rectangle 
around the graphic.   

 
5.  Add text:   

• Click the Typewriter Tool.  Select a font, size, and style from the Options Tray.  
Scroll to choose a font, or double-click the font window to choose a font from a 
list.  Select a color from the Color Palette.  Click to plant the cursor on the 
screen.  Begin typing.   

 
6.  Record a sound: 

• Under the Goodies Menu, choose Record a Sound.  Click the Record Button.  
Record your text for the title slide.  Click the Stop Button.  Click the Play Button 
to preview the recording.  Click Save. 

 
7.  Save slide 3: 
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• Select Save a Picture under the File menu.  Choose a location in which to save.  
(floppy disk - A drive)  Name your picture (slide3).  Select Save Sound.  Click OK. 

Slide 4: 
 
1.  Add a new page: 

• Choose New from the File menu. 
• Add content 

 
4.  Record a sound: 

• Under the Goodies Menu, choose Record a Sound.  Click the Record Button.  
Record your text for the title slide.  Click the Stop Button.  Click the Play Button 
to preview the recording.  Click Save. 

 
5.  Save slide 4: 

• Select Save a Picture under the File menu.  Choose a location in which to save.  
(floppy disk - A drive)  Name your picture (slide4).  Select Save Sound. Click OK. 

 
Pulling slides into a slide show: 
 
1.  Insert the slides 

• Under the File menu, choose Return to Picker. 
• Click SlideShow. 
• In the first moving van, click the picture button (lower left, beside the music 

note).   
• Insert slide one.  Directories: A drive.  Files:  slide1.  Click slide1.bmp.  Click OK. 
• Insert slide two.  Click the picture button on the second moving van.  Click 

slide2.bmp.  Click OK. 
• Insert slide three.  Click the picture button on the third moving van.  Click 

slide3.bmp.  Click OK. 
• Insert slide four.  Click the picture button on the fourth moving van.  Click 

slide4.bmp.  Click OK. 
 
2.  Choose or add sound: 

• Click the music button on the first moving van.  
• Choose a sound.   

The black box contains Kid Pix sounds. 
The abc option selects the computer voice to read story to you.   
 (Available only in Kid Pix Studio Deluxe.)  
The Kid Pix option selects a sound you recorded while in Kid Pix. 
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The microphone option enables you to record a sound now. You have 16 seconds 
for a recorded sound. You may choose More Sounds to access .wav files and 
import a sound. You may choose no sound. 

• Click Select. 
• Follow the above steps to add sound to remaining slides. 
 

3.  Add transition: 
• Click the transition button to the right of the music note.   
• Click to select a transition. 
• Click preview to view the transition. 
• Click Select. 
• Follow the above steps to add transitions to remaining slides. 

 
4.  Add a second sound to the ending slide: 

• On slide four, record a sound “The End.” 
• Choose a scissors transition. 
• For the fifth moving van, import slide four again.   
• Choose a different sound for this slide - hands clapping, for example. 
• When the slide show plays, you will hear “The End” followed by applause. 
 

5.  View or change time for each slide: 
• Click and hold the gray button on the time slide bar to view the current time 

elapsed for that slide.  The time slide bar is below the truck.  Click the gray 
button to the right of the yellow mark. 

• Click and drag the gray button to increase or decrease the time for each slide.  
Slide will play for at least the length of the time the sound plays, with a 
maximum of 30 seconds per slide. 

 
6.  Rearrange slides: 

• Click and drag the moving van to the desired location to rearrange slides. 
 

7.  Delete a slide: 
• Click to select the slide you wish to delete.   
• Click the dynamite. 
 

8.  Undo your last operation: 
• Click the undo man immediately. 
 

9.  View slide show: 
• Click the triangle button at the bottom of the screen to view the slide show once.  
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• Click the boxed triangle to play the slide show looped.  Double click to stop the 
looped slide show. 

 
10.  Save slide show: 

• File menu - Save a Slide Show - make sure Kid Pix pictures (.bmp files) and 
slide show are saved in the same location.  You will need Kid Pix Studio 
software to run this slide show.  This saving option enables you to edit the slide 
show. 

• File menu - Save an AVI - saves your slide show as a movie file which may be 
viewed in Wacky TV. 

• File menu - Save a StandAlone - saves your slide show by itself.  It saves the 
slide show as an executable file, with a .exe extension.  It will run without Kid Pix 
Studio software; however, you will not be able to edit. 
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Comparing Whales 
Teaching 
Strategies 
Modeled 

Technology 
Strategies 
Modeled 

Instruction 
Essential Questions for Teachers:  How do I use a multimedia CD in my 
classroom?  How do I use Excel?  How do I create a slideshow in KidPix? 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Essential Question: How are baleen whales different than 
toothed whales?  How big are whales?  What are the names of 
some different whales? 
 
Learning Standards (State of Michigan): 
Assessed:  
English Language Arts Standard 3:Later Elementary  
Integrate listening, speaking, viewing, reading, and writing skills 
for multiple purposes and in varied contexts. An example is using 
all the language arts to prepare and present a unit project on a 
selected state or country. 
 
Mathematics Standard III.1: Elementary  
Collect and explore data through counting, measuring and 
conducting surveys and experiments. 
 
Mathematics Standard III.1: Elementary 
Present data using a variety of appropriate representations and 
explain the meaning of the data. 
 
Non-assessed: 
Science Standard I.1: Elementary 
Generate reasonable questions about the world based on 
observation. ( Key concepts: See Using Scientific Knowledge. 
Real-world contexts: See Using Scientific Knowledge.) 
 
Materials: Whales Multimedia Literature CD (by 
MacMillian/McGraw-Hill), student reproducibles, Excel, Whale 
Cards, KidPix, Internet connection 
 
Technology Connections: Students will view information about 
whales on the Whales Multimedia Literature CD.  Using that 
information, they will create a graph in Excel.  They will research 
whales on the Internet and create a KidPix slide show to share 
with the class. 
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Teaching 
Strategies 
Modeled 
 
Whole 
Group 
Instruction 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Individual 
Activity 
 
 
 
 
 
 
 
Each One, 
Teach One 
 
 
 
 
 
 
 
 
Partner 
Activity 
 
 
 
 
 
 
 
 
 

Technology 
Strategies 
Modeled 
 
Whales 
Multimedia 
Literature CD 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Spreadsheet 
 
Tips for 
Using 
Spreadsheets 
in the 
Classroom- 
http://yankee
.sburl.k12.vt.u
s/district/ite
/usingspreads
heets.htm  
 
ABC’s of 
Excel- 
http://www.m
indspring.com
/~kadkins/AB
C.htm  
 
 
 
 
 
Internet- 
http://tracks
tar.hprtec.or
g/main/displa
y.php3?option
=frames&trac
k_id=39790 

 
3-5 Procedures: 
Introduction 

1.  As a class look at the Whales Multimedia Literature CD.  
Follow the directions to create a KWL chart using the 
software.   
2.  Take students through the mural on the CD according 
to the directions that follow and add to the L column of 
your KWL chart as you learn information. 
3.  Show students the electronic version of Seymour 
Simon’s Whales on the CD.  Give each student both pages 
of the Whales fact-gathering sheet to complete with 
information they learn during the CD. 
  

Graphing Whale Size 
4. Have students take the data that they gather about 
whale size on their fact-gathering sheet and put it into a 
spreadsheet according to the directions that follow. 
5. Follow the directions to create a chart using the chart 
wizard in Excel. 
 

Researching Whales 
6. Explain that students are now going to be assigned a 
whale to learn more about.  Each pair of students will be 
responsible for teaching the rest of the class about a 
particular whale. 
7. In the morning before class, tape a whale card to the 
bottom of each student’s seat.  Make sure that you 
distribute two of each whale card.   
8. On your signal, students are to reach under their chair 
and get their whale card.  They need to find the other 
person who has the same whale.  That will be their 
assigned partner. 
9. Show students the Trackstar at 
http://trackstar.hprtec.org/main/display.php3?option=fra
mes&track_id=39790 Give each pair of students a Whale 
research sheet on which they can record facts about their 
whale. 
10. Allow pairs of students to start looking for information 
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Teaching 
Strategies 
Modeled 
 
Partner 
Activity 
 
 
 
 
 
 
 
 
 
Each One, 
Teach One 
 
Partner 
Activity 
 
 
 
Whole 
Group 
Presentation
s 

Technology 
Strategies 
Modeled 
 
 
 
Internet- 
Puzzlemaker 
 
 
 
 
 
 
KidPix Studio  

about their whale using the sites listed on the Trackstar. 
11. When they have collected enough data, they can go on 
to the final step of the Trackstar and create a word 
puzzle in Puzzlemaker using 10 whale words that they 
learned in their research. 
 

Each One, Teach One 
12. Have students work together to create a KidPix slide 
show on the Whale storyboard.  Make sure that they 
include the required elements on each slide. 
13. Show students how to copy and paste graphics from 
the Internet to use in their slide show. 
14. Follow the directions for creating your slide show. 
15. When all slide shows are complete, have students 
present their slide show to the class, teaching other 
students about their whale.   
16. While students are presenting their slide shows 
classmates will fill out the Listening Record Sheet with 
basic information about each whale. 
 

Assessment: Students will be assessed on their presentation 
using the checklist at 
http://pblchecklist.4teachers.org/view.php3?id=1847.  Their 
answers to the fact-gathering sheet and their spreadsheet will 
also be evaluated for accuracy. 
 
Extension: Have students take the information from their 
Listening Record Sheet and enter it into a whale database. 
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Whale Fact Sheet 
 
 
 
 
Name 3 different kinds of whales: 
 
 
 
 
How do Whales breathe? 
 
 
 
 
 
How do whales swim? 
 
 
 
 
 
What’s a fluke? 
 
 
 
 

Draw a picture of a whale: (see page 12)
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Whale Research Sheet 
Using the 5 different stations find information about your whale. Make sure you research 
all items at all stations. You may find conflicting information 
that needs to be resolved.  
 
Be sure to find out the following information: 
Baleen or Toothed: 
 
Diet: 
 
 
 
Body Size: (Adult) Length/Weight 
 
 
Population-Endangered? 
 
Habitat: 
 
 
 
 
Migration pattern: 
 
 
 
Interaction with humans: 
 
 
 
 
Other Facts (use other sheet if necessary) 
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Whales Fact-Gathering Sheet 
 

      What are the two different types of whales? 
 
 
 
 
Complete the Venn diagram with information about each type of whale. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
Please list examples of each type: 

 
Baleen    Toothed 
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Group Fact Sheet 
 

Name of 
Whale 

Baleen 
or 

Toothed 

 
Diet 

 

Body 
Size 

Migration 
Pattern 

Human 
Interaction 

Habitat 

Sperm 

 
 
 
 
 
 

     

Beluga 

 
 
 
 
 
 

     

Sei 

 
 
 
 
 
 

     

Gray 

 
 
 
 
 
 

     

Blue 
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Comparing Whales 
 
 

Comparing Whales 
 

Name of Whale Length of full-
grown Adult Whale 

in feet 

Weight of full-grown 
Adult Whale in tons 

Sperm 60 50 
Beluga 30 9 

Sei 50 70 
Gray 90 80 
Blue 110 150 

Average 68 71.8 

 

Whale Comparison

0
20
40
60
80

100
120
140
160

Sperm Beluga Sei Gray Blue

Length of full grown
adult whale in feet
Weight of full grown
adult whale in tons
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Creating a Whale Graph in Excel 
 
1. Click and drag over cells A1-C1.  Click the Merge and Center button on the top toolbar.   
2. Type in the title “Comparing Whales” in the enlarged cell.  Select those words and 

change the size to 18, and click on the Bold button. 
3. In cell A2, type the words “Name of Whale”.  In cell B2, type the words “Length of full-

grown Adult Male in Feet”.  In cell C2, type the words “Weight of full-grown Adult Male 
in Tons”. 

4. Click and drag over cells A2-C2 to select them.  Change the size to 12 points. 
5. With those cells selected, click on Format and Cells.  Then click on the Alignment tab at 

the top.  Click on Wrap text under the Text Control heading.  Click OK. 
6. Select those cells again, and click on the center button on the top toolbar.   
7. Then size your columns to the desired width by clicking and dragging between the gray 

column headings. 
8. Click in cell A3.  Type in the name of the first whale.  In column A, continue to enter 

the names of each whale on the fact gathering sheet. 
9. In column B, enter the length of each and in column C, enter the weight. 
10. In cell A8, type the words “Average”. Make it bold. 
11. To create a formula to average columns B & C, click in cell B8.  Then click on Insert and 

move down and click on Function.  Choose the word average from the column at the 
right and click OK.  Check to make sure that Excel has chosen the correct range for 
your average.  If not, you’ll need to click and drag to select the correct range of cells.  
Click OK.  The average will appear in the cell. 

12. Repeat step 11 for cell C8. 
13. Create your graph.  Click and drag to select cells A2-C7.  Do not include the averages in 

your selection.   
14. Click on the Chart Wizard button on the top toolbar.  It’s the one with the three 

colored bars. 
15. Choose your chart type.  Choose column graph. 
16. Click Next.  Then click Next again.  Click Next and then Finish. 
17. Your graph will now appear on your spreadsheet.  Click and drag the border of the graph 

to place it in the desired location on your spreadsheet. 
18. Print your spreadsheet.  Click on File and Print Preview.  Click on Setup, then on the 

Sheet Tab.  Click in the box beside the word gridlines to print the lines with your 
spreadsheet.  Then click on Print. 
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Software 
Helpers 
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Software Helper 
 Kid Pix 3 

Using KidPix Deluxe 3 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
When you open up the program, the Paint Zone is revealed.  Here is an overview of the 
tools in the Paint Zone and how to use each one to create picture files. 
 
Background- Click on the Background button to see a variety of backgrounds displayed.  
Choose a category using the up and down arrows that appear under the main screen and 
then click and drag the background of your choice to the middle of the screen.  To see 
more backgrounds from within that category, click on the up and down arrows that appear 
to the right of the background selections. 
 
Stickers- Click on the Sticker button to see categories of stickers displayed.  Choose a 
category using the up and down arrows that appear under the main screen and then click 
and drag the sticker of your choice and place it on the middle of the screen.  To see more 
stickers from within that category, click on the up and down arrows that appear to the 
right of the sticker selections.  The stickers can be sized and altered using the handles 
that appear around the sticker.  The pink arrow boxes that appear in the upper left and 
lower right hand corners allow you to click and drag the graphic to size.  The other pink 
handles in the lower left and upper right hand corners allow you to change the orientation 
of the graphic.  Clicking in the center of the graphic allows you to drag and move it to 
various places on the picture. 

Background 

Stickers 
Animation 
Sounds 
Undo 

Draw 

Paint Bucket 

Stamps 
Moving 

Play

Save
New Picture

Bomb
Background

Print

Help

Paint

Electric Mixer
Text Tool

Eraser

Color Picker 
Slide Show

Texture
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Animation- Clicking on the Animation button allows you to choose animated stickers to add 
to your picture.  Choose a category using the up and down arrows that appear under the 
main screen and then click and drag the animated sticker of your choice and place it on 
your picture.  To see more animations from that category, click on the up and down arrows 
that appear to the right of the animation selections.  The animations can be sized and 
viewed by using the handles that appear around the outside of the graphic.  The pink arrow 
boxes that appear in the upper left and lower right hand corners allow you to click and 
drag the graphic to size.  The pink handle in the lower left corner plays the animation, 
while the handle in the upper right hand corner allows you to stop the animation.  Clicking 
in the center of the graphic allows you to drag and move it to various locations on your 
picture. 
 
Sounds- Click on the Sounds button to choose a sound to add to your picture.  Choose a 
category using the up and down arrows that appear under the main screen and then click 
and drag the sound picture of your choice and place it on your picture.  To see more sounds 
displayed in that category, click on the up and down arrows that appear to the right of the 
sound selections.  Hear your sound by clicking on the Play button in the upper right hand 
corner. 
 
Undo- Click on this button to undo the last thing that you did to your picture. 
 
Draw- Clicking on the pencil tool brings up a set of drawing tools at the bottom of the 
screen.   
Drawing tools from left to right: 

 The Pencil Tool draws solid lines and shapes. 
 The Chalk Tool draws smooth lines and shapes. 
 The Crayon Tool draws fuzzy lines and shapes. 
 The Marker Tool draws tinted lines and shapes. 
 The three dots in the middle change the thickness of the line you draw. 
 The squiggly line allows you to draw freely. 
 The other tools on the left hand side allow you to draw various shapes, either open 

or filled with the selected color. 
 
To use the drawing tools, simply click and draw or click and drag on the screen.  To change 
the color, click on the large splotch in the lower left hand corner of the screen and select 
the color of your choice. 
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Paint- Clicking on the Paint button enables you to paint with the paint brush, sound art, or 
spray can tools found at the bottom of the screen. 
Painting tools from left to right:  

 The Paint Brush tool allows you to add realistic and wacky 
paint to your picture.  Choose the tools displayed on the 
menu on the right to choose the style of paint.  Click on the colored shapes button in 
the center to see Wacky Paint brush options.  The three dots in the center change 
the size of the line that you draw. 

 The Sound Art tool allows you to add paint to your picture using your voice and/or 
the computer mouse.  Click on the various tools on the right hand side of the menu 
to choose different options. 

 The Spray Can tool allows you to spray shapes or moving paint onto your picture.  
Click on the various tools on the right hand side of the menu to choose different 
options and shapes. 

 
Paint Bucket- Clicking on the Paint Bucket enables you to fill areas with colors or patterns 
using the tools displayed at the bottom of the screen. 
 
Paint Bucket tools from left to right:  

 The first bucket fills an area with the selected color and 
pattern. 

 The second bucket fills an area with a blend of colors.  Hold down the mouse button 
when you add colors, then move the mouse to get the blend you want. 

 The third bucket fills an area with a multicolor pattern. 
Clicking on each paint bucket reveals various choices to the right of the buckets.  Use the 
up and down arrows on the right hand side to scroll through the different options. 
 
Electric Mixer- Clicking on this tool will enable you to transform all or part of your 
picture. 
Mixer tools from left to right:  

 The first mixer enables you to transform your whole picture with one mouse click. 
 The second mixer wand enables you to smudge, smear, warp, or twist your picture. 

Clicking on each mixer reveals various choices to the right of the buckets.  Use the up and 
down arrows on the right hand side to scroll through the different options. 
 
Stamps- Clicking on this tool will allow you to add rubber stamps to your picture.  Choose a 
category from the bottom left hand side to see different stamps revealed.  Use the 
arrows on the right hand side to scroll up or down to browse the collection.  Click and drag 
on the stamp of your choice to see it displayed on the screen.  Use the three dots in the 
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center to determine the size of the stamp.  The pencil tool enables you to customize the 
stamp and choose alternative colors. 
 
Text Tool- Click on this tool to add words to your page, then click on the page to get a 
text box for typing.  The pink handles in the corner of the text box enable you to click and 
drag the text box to size.  The blue bar across the top will allow you to click and drag the 
text into position. 
 
Text tools from left to right: 

 
 

 Change the font, size, style, and justification using the menu in the lower left 
section. 

 The Scissors allows you to cut a selected text box.  You can place the cut text in a 
new text box by clicking on the Paste tool to the right. 

 The two smiley faces indicate the Copy tool.  Select the text and click on the Copy 
tool.  Create a new text box and click on the Paste button below to see the text 
repeated in your new text box. 

 The Speech button reads the selected words on your page out loud.  Choose the 
preferred voice from the menu to the right. 

 
Moving Tool- Clicking on the Moving tool enables you to 
grab, cut, and move parts of your picture around. 
 
Moving tools from left to right:  

 The gloved hand moves stickers, animations, and text boxes around.  Click on the 
glove and simply move the objects to the desired location. 

 The scissors enables you to cut, copy, and paste selected parts of your picture.   
Click on the scissors, then click and drag around the area you wish to select.  Use 
the Copy, Delete, and Paste tools on the right to perform the desired action.  Other 
shapes are displayed to the right that can be used to select areas of your picture. 

 
Eraser Tool- Click on the Eraser to erase all or part of your picture. 
 
Eraser Tools from left to right:  

 The mini eraser allows you to erase part of your picture by hand. 
 The big eraser clears your whole picture with one click.  Choose the way that you 

wish for your page to be erased from the choices give on the right. 
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Create a New 
Slide Show 

Slide Boxes

Saved Slide Shows Displayed Here

Return to the 
Paint Zone 

Effects, Print, 
and Save 

Slide Show 
Viewer 

Color Picker- Click on the Color Picker to choose a color.  Click on a color swatch, or use 
the eyedropper tool to pick up any color from your picture to use with the art tools. 
 
Slide Show- Click on this button to go to the slide show feature.  Before going to the slide 
show, you must have your pictures saved to a disk or your hard drive. 
 
Help- Click on this button and then click on any part of the screen that you need help with. 
 
Printer- Click here to print your picture.  Choose from full page or poster printing. 
 
Exit- Click here to exit the program. 
 
Bomb- Click on this button, then on the screen to erase your whole picture. 
 
Texture Tool- Click on the texture tool to change the paper texture.  Use the chalk, 
crayon, or marker to see the paper texture when you draw. 
 
New Picture- Click on this button to begin a new picture. 
 
Save- Click on this button to save your picture to a disk or your hard drive. 
 
Creating a Slide Show in KidPix Deluxe 3 
Multimedia Slide Shows are simple to create!  Below are the directions for creating your 
own multimedia wonders! 
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Steps for creating your slide show:  
1. Create all of the pictures that you wish to add to the slide show in the Paint Zone 

and save each one. 
2. Enter the Slide Show Creator.  Click on the green button under the first slide.  

Locate your saved picture file, click on the file name, and click Open to place the 
slide on the slide show creator.   

3. Click on the movie camera to choose the effects that you wish to include in your 
slide show.   Click on the large red arrow that appears between each slide and 
choose the transition and sound that you would like to see as each slide is displayed.  
Once you have made your selection, click on the Preview button to see your slide 
displayed.  Click on the OK button when you are satisfied with you choice. 

4. Next, click on the yellow box under each slide to choose the Page Advance options.  
Set the timer if you prefer for your slides to automatically advance.  Click on Mouse 
Click if you would like to advance the slide by clicking with the mouse.  Choosing Key 
Down enables you to control the progression of the slides using the down arrow on 
your keyboard.  Read Text Done advances the slide after all text has been read 
aloud.  Click OK when you have made your selection. 

5. Finally, click on the speaker button under each slide to set the Audio Options.  This 
feature allows you to play sound, read the text, or a combination of both.  Click OK 
when you have made your selection. 

6. You can quickly reorder your slides by clicking on the center of the thumbnail slide 
and dragging it to the desired location. 

7. To save your slide show, click on the disk button and type in a file name.  After your 
file has been saved, you should see it appear in the blue menu at the bottom of the 
screen. 

8. To delete a slide or an entire slide show, click on the slide or slide show file icon at 
the bottom of the screen and drag it to the trash can. 

9. You can print a copy of the slides in your show by clicking on the print button.  You 
are given several printing options:  

 Print a full page with one slide on each page 
 Print it as a comic book with up to six slides per page 
 Print as a foldable card or booklet with up to four slides per page 
 Print a thumbnail version of the show with up to 24 slides per page. 

Select whether you wish the page to be portrait or landscape, then how many slides 
you wish to include in the printing command.  You can only print enough slides to fill 
one page at a time. Click OK when you are ready to proceed. 

10. To play your slide show, click on the green arrow on the right hand side. 
11. To return to the Paint Zone, click on the arrow with the purple splotch. 
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Software Helper 
 Spreadsheets with Microsoft Excel 

 
Vocabulary: 
 

Workbooks- Excel files are called workbooks.  Each workbook contains three 
worksheets.  Tabs at the bottom of the screen separate them. 
Worksheets- A spreadsheet in a workbook. 
Cell- The “boxes” in a spreadsheet. 
Formula- A formula tells Excel to perform a calculation.  A formula must begin with 
an equal sign. 

 
Entering and Editing Information: 
 
Entering Information: Click a cell to make it active.  You can move the cursor by clicking 
with your mouse or with your arrows on the keyboard. 
 
Enlarging Columns and Rows- Click between the column or row headings and drag.  Double-
click for the column or row to automatically resize. 
 
Copying data: If you need to enter the same data into a number of cells, select all of the 
cells in which you want the data to appear.  Enter the information in the top cell and press 
Ctrl+Enter for windows or Code+Enter for Mac. 
 
Editing Information: To change information in the cell, click on that cell and edit it in the 
formula bar at the top. 
 
AutoFill: To automatically fill in numbers from a series, click on the cell and fill in at least 
two cells with the numbers you want entered.  Select both cells and drag down the fill box 
to include the desired cells.  AutoFill will automatically fill in the selected cells with 
consecutive numbers. 
 
Adding comments: You can set comments for each cell by selecting the cell and choosing 
Comment from the Insert box.  Enter the text for your comment in the text box.  Click on 
any cell when you are finished.  The cell will not have a small red triangle in the upper-right 
corner to show that the cell contains a comment.  When you place your cursor over the 
cell, you will be able to view the comment. 
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Spell Check- You can check your spelling by clicking on Tools and Spelling or clicking the 
check ABC button on the top tool bar. 
 
AutoFormatting- Choose a pre-set autoformat by selecting the cells that you wish to 
format and clicking on Format and Autoformat. 
 
Aligning Cell Contents- You can change the alignment of the information in the cells by 
selecting the cells that you wish to align and clicking on format and Cells. 
 
Background colors and patterns- Select the cells that you wish to change.  Choose Cells 
from the Format menu.  Click on Patterns and choose a color. 
 
Merging Cells- To create a title for your spreadsheet or to merge two or more cells, select 
the cells that you wish to merge and click on the merge and center button on the top 
toolbar. 
 
Inserting Rows and Columns- Click on the row or column heading where you wish to have 
the cells inserted.  A row will be inserted below where you have a cell selected, and a 
column is inserted to the right of where you have a cell selected. 
 
Working with Worksheets 
 
Inserting and Renaming Worksheets- Choose Worksheet from the Insert menu and a new 
worksheet will be added to the bottom.  To change the name of a worksheet, right click on 
the tab (Control + click for the Mac) and choose rename. 
 
Freezing Rows and Columns- Freeze rows or columns when you want to see the same rows 
and columns as you move anywhere else in your worksheet.  Move your cell pointer to the 
right of the column that you want to freeze and below the row that you want to freeze.  
Choose Freeze Panes from the Windows menu. 
 
Sorting a list- You can sort a list based on the list’s values.  You can rearrange rows in 
ascending or descending order.  Move the cell pointer to the column you want to sort.  Click 
the sort ascending button or the sort-descending button. 
 
Formulas 
 
Entering Formulas manually- All formulas must begin with an equal sign.  Select the cell 
where you want to place your formula.  Start your formula with an equal sign and type in 
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the formula (ex. =C1+C2+C3).  Make sure that you do not leave any spaces.  Press enter and 
the formula will appear in your box. 
 
Using built-in formulas: There are several ways to calculate the same problem using 
formulas. =C1+C2+C3 can also be expressed this way:  =SUM(C1:C3). 

To use the formulas built in to Excel: Click in the formula bar and type in an equal 
sign.  Click beside the formula in the box where it says SUM and choose your 
function.  The beginnings of a formula will appear.  Click on the cells that you wish to 
include or click and drag to include a range.  Press enter on your keyboard. 

 
Charting 
 
Creating a Chart- Select the data that you want to use in your chart.  Include the labels in 
your selection.  Click on the Chart Wizard button or choose chart from the Insert menu.  
Go through the Options provided to create your chart. 
 
Adding new data to a chart- Enter the new data on the spreadsheet.  Click on the chart to 
select it and click on Chart and Add Data.  Move the window out of the way and select the 
new data that you want to add.  The range will now appear in the box in that new window.  
Click OK and the new data will be added to your chart. 
 
Changing the Chart type- Activate the chart by clicking on it.  Select Chart Type from the 
Chart menu. 
 
Moving a Chart Element- Click on the element within the chart that you want to move and 
drag it to another location. 
 
Printing 
 
To print Grid Lines- Click on File and Print Preview, Setup and Sheet.  Click in the box next 
to Gridlines. 
 
To change the Orientation- Click on File and Page Setup.  Click Portrait or Landscape. 
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Supplemental 
Lesson 
Plans  
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Charting Whale Migration 
Teaching 
Strategies 
Modeled 

Technology 
Strategies 
Modeled 

Instruction 
Essential Questions for Teachers:  How do I use e-mail in the classroom for 
peer editing?  How do I create a time line using TimeLiner?  How do I create a 
postcard in Microsoft Word? 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Essential Question: What is migration?  Why do whales 
migrate?  How far does the Gray Whale migrate?  Where does it 
travel? 
 
Learning Standards (State of Michigan): 
Assessed:  
English Language Arts Standard 7: Later Elementary  
Develop and use a variety of strategies for planning, drafting, 
revising, and editing different forms of texts for specific 
purposes. Examples include brainstorming, revising with peers, 
sensitivity to audience, and strategies appropriate for purposes, 
such as informing, persuading, entertaining, and inspiring. 
 
Social Studies Standard II.2: Later Elementary 
Explain basic ecosystem concepts and processes. 
 
Non-assessed: 
Science Standard I.1: Elementary 
Develop solutions to unfamiliar problems through reasoning, 
observation, and/or experiment. ( Key concepts: See Using 
Scientific Knowledge. Real-world contexts: See Using Scientific 
Knowledge.) 
 
Materials: Imagination Express: Ocean, student reproducibles, 
Internet connection, TimeLiner software, Microsoft Word, e-
mail access 
 
Technology Connections: Students will learn about whale 
migration using the Imagination Express: Ocean CD.  They will 
then conduct research on the Internet and create a time line.  
Finally, they will make a postcard in Microsoft Word. 
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Teaching 
Strategies 
Modeled 
 
Whole 
Group 
 
 
 
 
 
 
 
 
Whole 
Group 
Instruction 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Individual 
Work 
 
 
 
 
 
Individual 
Work 
 
 
 
 
 
 
 
 
 
 
 

Technology 
Strategies 
Modeled 
 
 
 
 
 
Imagination 
Express: 
Ocean 
 
 
 
 
 
 
Internet- 
http://www.o
cregister.com
/science/feat
ures/seaview
/whales/migr
ation/new_mi
gration_shock
.shtml 
Scan 
Converter 
 
 
 
 
 
 
TimeLiner 
TimeLiner 
Teacher Tips- 
http://www.t
omsnyder.com
/classroom/ti
melineronline
/tt.html  
 
 
 
 
Microsoft 
Word 
 
E-mail 
 
 

3-5 Procedures: 
Introduce the students to Whale migration with Imagination 
Express: Ocean.  To access the information, open the program.  
Sign in and click on the Fact Book.  Click on Animal Migration.  
Read the information to students.  Then click on the movie 
camera to see animation.  Click on the Stop sign to exit. 
 
Charting Grey Whale Migration: 
1. Give each student a copy of the map.  Go to 

http://www.ocregister.com/science/features/seaview/whales
/migration/new_migration_shock.shtml.  Show this site on the 
scan converter for all students to see.  Look at the map on 
the site and have them chart the migration of the Grey 
Whale on their map with a red crayon or marker. 

2. As a group, write positional clues that describe where the 
Grey Whale can be found each month using the locator on the 
site.  Simply change the month and the day.  Begin with 
January 1 and have students record it in the chart on their 
paper.  Then enter February 1 and so on, until you get to 
December 1.  For example: January 1, Off the Northern Coast 
of Canada. 

3. Now, take that information and create a time line using 
TimeLiner software.  Follow the directions for creating your 
time line.  Allow each student to print his/her time line. 

 
Postcard Home 
4. Have students pretend that they are Grey Whales.  Ask them 

to create a postcard to his friends “back home”.  Include 
information about his current location and other relevant 
facts. 

5. Follow the directions to demonstrate how to create a 
postcard in Microsoft Word. 

6. Have students e-mail their completed postcards to a peer for 
editing. Ask the peer to make any comments and reply to the 
e-mail. 

7. Show students how to print their postcards and display in the 
room. 

8. Have students fill out a self-assessment of their completed 
postcard. 
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Teaching 
Strategies 
Modeled 

Technology 
Strategies 
Modeled  
 
Using E-mail 
in the 
Language 
Arts 
Classroom- 
http://www.t
echlearning.co
m/db_area/a
rchives/WCE
/archives/chu
ck.htm  

 
Assessment: Students will be assessed on their completed 
postcards using a rubric. 
 
Extension: Have student’s research the migratory patterns of 
another whale and compare it to that of the Grey Whale. 
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Charting the Migration of the Grey Whale 
 
 

Date Where they will be… 
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Creating your Migration Time Line 
 

1. Open TimeLiner program. 
2. Click on New.  Then click on Floating. 
3. Double-click on the word Monthly, then on OK. 
4. Begin to enter your information in the boxes.  Hit the enter key on your 

keyboard to create a new entry.  
5. Click on View and Banner.   
6. To change the font size, click on Edit and Select all Events.  Then click on Format 

and Set Event Font.  Change the size to 14 point. 
7. To size the event flags, click on the flag to select it, then click on the black box 

to the right of the flag.   
8. To move your flags around, click and drag them to the desired location.  
9. To change the look of your flags, click on the flag to select it.  Then click on the 

grayed section to the left of the flag and choose a style. 
10.  Change those events in which the whales are traveling south to black flags. 

Leave those in which the whales are traveling north white. 
11. Print your time line. 
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1. Name the 2 Web based tools that help guide our research on whales? 
 
 
 
2. How do you select multiple cells in MS Excel? 
 
 
 
 
3.  Name 3 of the tools in KidPix? 
 
 
 
 
4.  I can import almost any picture into KidPix.  True/False 
 
 
 
 
5.  How do you save an attachment to your computer from an email? 
 
 
 
 
 
 
 
 
 
 
 
 




